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Foreword 
 

ADVISOR Enterprise is a Training Management System that drives training efficiency by (a) aligning current and 
future training activities to operational requirements to identify gaps, duplications and training with minimal 
value; (b) forecasting and comparing the costs of viable delivery options; (c) uncovering cost drivers; and (d) 
improving resource allocation.  ADVISOR is built around the ADDIE model with the added flexibility of starting the 
analysis at any level. ADVISOR is made up of the following modules that can be used separately or in any 
combination.  
 

 

Needs 
Assessment 

AssessΥ ¢ƻ ŦƛƴŘ ƻǳǘ άthe cause of the problem and potential solutionsέΦ  Provides a step by step approach 
for understanding a problem before selecting the solution ς in other words, before assuming that training 
is needed.  Needs Assessment provides an audit trail and serves as the foundation for decisions by zeroing 
in on the source of the problem, identifying solutions that can produce the desired level of productivity, 
and highlighting actions that will generate the greatest impact. [Scope and Needs Assessment]. 
 

Training  
Analysis 

AƴŀƭȅǎƛǎΥ ¢ƻ ŦƛƴŘ ƻǳǘ άwho needs to be trained, on what and whyέΦ  trovides a step by step approach for 
conducting Training Needs Analysis (TNA) or Training Systems Requirements Analysis (TSRA) to identify 
training needed by each job, position and employee to perform duties to the desired standard under the 
prescribed conditions. Four approaches may be used to conduct training analysis, namely Mission, 
System, Competency or Job.  [Mission Analysis, Competency Analysis, System Analysis, Job Task Analysis, 
Knowledge/Skill Gap Analysis and Training Requirements Analysis]. 
 

Training  
Design 

DŜǎƛƎƴΥ ¢ƻ ŦƛƴŘ ƻǳǘ άwhat is the most effective and economical way to deliver trainingέΦ  Provides a step 
by step approach for conducting Training Media Analysis (TMA) or Option Analysis to identify the most 
cost effective strategy for the delivery of training and generates Training Plans.  The analysis takes into 
account limitations, instructional design requirements, upfront and recurring costs over training program 
life as well as risks associated with the introduction of new technology. [Media Analysis, Cost Analysis and 
Training Plans]. 
 

Fidelity  
Analysis 

DŜǾŜƭƻǇΥ ¢ƻ ŦƛƴŘ ƻǳǘ ǘƘŜ άfidelity requirements of training devicesέΦ  Provides a step by step approach for 
assessing the functional requirements of trainers and simulators based on training needs and 
performance objectives.  It identifies visual, tactile, olfactory, affective and auditory sensory cues needed 
to practice tasks, within realistic environments, under preset conditions to attain the desired level of 
competency.  In addition, ADVISOR takes into account elements within the virtual world and how users 
interact with each. 
 

Resource 
Management 

IƳǇƭŜƳŜƴǘŀǘƛƻƴΥ ¢ƻ ŦƛƴŘ ƻǳǘ άhow much money and resources are neededέΦ /ompiles and analyzes 
missions/goals, competencies, systems, jobs, tasks, training requirements, courses, activities, costs, 
personnel and resources to generate concise, up to date and actionable reports.  The reports provide 
insight on planned training activities for any time period; training requirements for each job/employee; 
budget, personnel and resource requirements, training impact as well as how to drive training 
effectiveness and efficiency by leveraging technology, improving resource allocation and identifying gaps, 
duplications and unwarranted training.  [Forecast and Optimize Training Budgets, Personnel and 
Resources]. 
 

Project 
Management 

IƳǇƭŜƳŜƴǘŀǘƛƻƴΥ ¢ƻ ŦƛƴŘ ƻǳǘ άhow training should be implementedέΦ  Provides a step by step approach 
for planning a project and tracking progress in real time. This includes the setup of phases and tasks, 
dependencies and constraints, timelines as well as the assignment of personnel and resources needed to 
complete.  Moreover, ADVISOR tracks progress by comparing hours worked and money spent on each 
task to project plan, to anticipate delays, facilitate the implementation of corrective measures, and keep 
projects on-time and within budget. [Develop Project Plans and Track Progress]. 
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Performance 
Analysis 

EǾŀƭǳŀǘƛƻƴΥ ¢ƻ ŦƛƴŘ ƻǳǘ άhow training impacts performance and organizational goalsέΦ  trovides a step by 
step approach for improving performance by zeroing in on the source of the problem and identifying 
solutions that can produce the desired level of productivity.  Moreover, ADVISOR highlights actions that 
will generate the greatest impact by assessing the feasibility of implementing plausible solutions as well 
as forecasting the costs, benefits and Return on Investment (ROI) of each intervention.  [Performance 
Gap Analysis, Root Cause Analysis and Cost Benefit Analysis]. 
 

Training Life 
Cycle 

Management 

ManageΥ ¢ƻ άcontinually uncover venues to drive training effectiveness & efficiencyέΦ  aŀƛƴǘŀƛƴǎ ǘǊŀƛƴƛƴƎ 
effectiveness and efficiency over time by continually assessing the impact of changes to missions, jobs, 
tasks, systems, policies, technologies, throughput, and so forth on training content and activities; as well 
as budget, personnel and resource requirements. This is attained through a digital-twin model that 
continually aligns training activities to operational requirements to identify gaps, duplications and training 
with minimal value.  Results (personnel/resource requirements for any time period; cost drivers; 
bottlenecks and deficiencies) are quickly and concisely communicated through dashboards.  Actions that 
drive training effectiveness and efficiency are also highlighted.  
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Approach 
 
Why is ADVISOR Enterprise so effective?  Because it focuses on operational requirements ς i.e., identifies 
the knowledge, skills and competencies needed by each job, position and employee to attain 
organizational missions/goals, as well as the most efficient way to achieve.  In addition, facts support the 
decision making process, helping you create consensus to stay the course. 
 

Using our proprietary methodology, your efforts unfold in four phases, as follows: 
 

 

Discover

ωDefine Missions/Goals.

ωIdentify Tasks needed by each Job/Position/Employee to attain missions/goals.

ωIdentify Training requirements.

ωOutline current Training Courses/Activities. 

ωFind out where money and resources are allocated.

Strategize

ωMap Training Courses/Activities to Operational Requirements to identify gaps, 
duplications and unwarranted training. 

ωAssesss alternate venues for the delivery of training.

ωUncover resource allocation.

ωUncover cost drivers.

Prioritize

ωPrioritize Training Courses/Activities - from highest to lowest impact on 
missions/ goals.

ωPrioritize recommended changes to current delivery options.

ωIdentify personnel/resources excess capabilities and bottlenecks.

ωIdentify strategies for mitigating high cost items.

Optimize

ωDevelop an implementation strategy starting with low risk, low cost, high 
impact options.

ωAlign personnel/resources with new strategy.

ωDevelop project plans and monitor progress.

ωAssess and validate results.  
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Training Design Module 
 

 

ADVISOR Training Design module provides a step by 
step approach for conducting Training Media 
Analysis (TMA) or Option Analysis to identify the 
most cost effective strategy for the delivery of 
training and generates Training Plans. The analysis 
takes into account limitations, instructional design 
requirements, upfront and recurring costs over 
training program life as well as risks associated with 
the introduction of new technology. 
 

 

 
 

 

 

 
 

 

  

ADVISOR enabled me to cut down my initial 
analysis from 30 days to one day. 

Cathi Billings 
Instructional System Specialist,  

Sheppard AFB 
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ADVISOR Features  ADVISOR Benefits 

Preliminary Analysis: Quickly assess the feasibility 
and potential savings that may result from using 
alternate delivery options. 

 
Facilitate Configuration: Align with CFITES, MIL-
HDBK-29612-2A or DSAT requirements in a single 
click, or set-up in-line with needs. 

Alignment Analysis: Link Learning Objectives in 
existing courses to operational requirements using 
a drag and drop function to identify activities that 
are no longer relevant. 

 Speed Data Collection: Collect data from Subject 
Matter Experts offline through custom-built Excel 
spreadsheets and upload to ADVISOR in a single 
click.  Exchange data with systems through xml. 

Objective Analysis: Identify and group Learning 
Objectives with similar characteristics based on 
.ƭƻƻƳΩǎ ¢ŀȄƻƴƻƳȅ ǘƻ ǎǇŜŜŘ ŀƴŀƭȅǎƛǎ ǿƛǘƘƻǳǘ 
compromising integrity. 

 Facilitate Collaboration: Store all data in a 
centralized database accessible anytime and from 
anywhere by team members with only a Browser; 
and track changes made by each individual. 

Media Analysis: Identify and rate viable delivery 
options for each Learning Objective by mapping 
instructional requirements to the capability of each 
media. Reasons for rating of each delivery option 
are automatically presented. 

 Speed Analysis: Minimize the number of media 
analyses to be performed without compromising 
integrity, by grouping Objectives with similar 
ŎƘŀǊŀŎǘŜǊƛǎǘƛŎǎ ōŀǎŜŘ ƻƴ .ƭƻƻƳΩǎ ¢ŀȄƻƴƻƳȅ ŀƴŘ 
analyzing as a single entity.  

Development Time Analysis: Forecast the time 
needed to develop one hour of training for viable 
delivery options based on industry averages. 

 

 Facilitate Reusability: Store common measures 
such as hourly rates of developers, instructors and 
support staff; per diem and travel costs; etc., in 
Templates to quickly forecast and compare money, 
personnel and resources needed. 

Cost Analysis: Store common measures such as 
hourly rates of developers, instructors and support 
staff; equipment, simulators and facilities costs, in 
Templates to quickly forecast and compare costs, 
personnel and resource requirements of viable 
delivery options over training program life cycle. 

 
Minimize Costs: Conduct what if scenarios in 
minutes to assess the impact of various blends of 
delivery options, build versus buy, use of internal 
versus external personnel, and so forth. 

 

Risk Analysis: Assess readiness to introduce new 
learning technology, highlight potential risks and 
corrective actions needed. 

 Preserve Integrity: Generate audit trail with one 
click to track where each requirement has been 
addressed. 

 

Training Plan Creation: Setup Lessons, assign and 
rearrange Lessons and Objectives with ease using a 
drag and drop function. 

 Speed Report Generation: Produce Objective and 
Media Analysis, Cost Analysis, Training Plans and 
dozens of reports in a single click. 

 

 

 

 

 

 

 

 
 

  

Live Fire Review identified £140 
million in savings over 10 years 

 
UK Army  

 

LVC TS study identified $49.3 million 
in savings over 10 years 

 
Canadian Army  
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Chapter 1: Getting Started 
 
 

1.1 Introduction 

 
Training efficiency and productivity can be further improved by uncovering the most effective and 
economical venues for the delivery of training ς i.e., how the knowledge and skills needed to 
achieve performance objectives should be learned.  Whether you are developing new training 
programs or assessing the viability of existing courses, instructor-led, on-the-job, self-paced, 
social based, eLearning, mobile learning, serious games, trainers, virtual reality as well as 
performance support systems should be considered.  Otherwise, valuable resources could be 
wasted. 

 
Once the advantages and limitations of various delivery options have been clearly articulated, 
effective and efficient training plans can be generated. 
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1.2 How Can ADVISOR Help You?  
 
In addition to simplifying and speeding Training Needs Analysis (TNA) and Training Systems Requirements 
Analysis (TSRA), ADVISOR Enterprise drives training efficiency by aligning current and future training 
activities to operational requirements to identify gaps, duplications and training with minimal value; 
uncovering cost drivers; forecasting and comparing the costs of viable delivery options; improving 
resource allocation; identifying/mitigating bottlenecks; producing training plans that leverage existing 
training programs/resources and generating audit trail to support recommendations.   
 
Moreover, ADVISOR preserves training integrity, effectiveness, efficiency and relevance by quickly 
identifying training activities that could be impacted by a change to a mission, system, job, policy or 
publication; facilitates reusability and collaboration by storing all data in a centralized database that can 
be accessed anytime and from anywhere by all team members with only a browser; simplifies data 
collection from Subject Matter Experts through custom build Excel spreadsheets; speeds data analysis; 
simplifies data manipulation; tracks changes made by each team member; and generates dozens of 
reports in a single click.  ADVISOR is also web based, can be installed on a local Server or used off BNH 
Server (cloud option), consists of 8 modules that can be used separately or in combination to meet various 
needs, and can be customized in line with requirements. 
 
More specifically, follows are !5±L{hw ά¢ǊŀƛƴƛƴƎ Designέ ƳƻŘǳƭŜ features and benefits.  
 

ADVISOR Features  ADVISOR Benefits 

Preliminary Analysis: Quickly assess the 
feasibility and potential savings that may result 
from using alternate delivery options. 

 
Facilitate Configuration: Align with CFITES, MIL-
HDBK-29612-2A or DSAT requirements in a single 
click, or set-up in-line with needs. 

Alignment Analysis: Link Learning Objectives in 
existing courses to operational requirements 
using a drag and drop function to identify 
activities that are no longer relevant. 

 Speed Data Collection: Collect data from Subject 
Matter Experts offline through custom-built Excel 
spreadsheets and upload to ADVISOR in a single 
click.  Exchange data with systems through xml. 

Objective Analysis: Identify and group Learning 
Objectives with similar characteristics based on 
.ƭƻƻƳΩǎ ¢ŀȄƻƴƻƳȅ ǘƻ ǎǇŜŜŘ ŀƴŀƭȅǎƛǎ ǿƛǘƘƻǳǘ 
compromising integrity. 

 Facilitate Collaboration: Store all data in a 
centralized database accessible anytime and from 
anywhere by team members with only a Browser; 
and track changes made by each individual. 

Media Analysis: Identify and rate viable delivery 
options for each Learning Objective by mapping 
instructional requirements to the capability of 
each media. Reasons for rating of each delivery 
option are automatically presented. 

 Speed Analysis: Minimize the number of media 
analyses to be performed without compromising 
integrity, by grouping Objectives with similar 
ŎƘŀǊŀŎǘŜǊƛǎǘƛŎǎ ōŀǎŜŘ ƻƴ .ƭƻƻƳΩǎ ¢ŀȄƻƴƻƳȅ ŀƴŘ 
analyzing as a single entity.  

Development Time Analysis: Forecast the time 
needed to develop one hour of training for viable 
delivery options based on industry averages. 

 

 Facilitate Reusability: Store common measures 
such as hourly rates of developers, instructors and 
support staff; per diem and travel costs; etc., in 
Templates to quickly forecast and compare money, 
personnel and resources needed. 
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Cost Analysis: Store common measures such as 
hourly rates of developers, instructors and 
support staff; equipment, simulators and 
facilities costs, in Templates to quickly forecast 
and compare costs, personnel and resource 
requirements of viable delivery options over 
training program life cycle. 

 Minimize Costs: Conduct what if scenarios in 
minutes to assess the impact of various blends of 
delivery options, build versus buy, use of internal 
versus external personnel, and so forth. 

 

Risk Analysis: Assess readiness to introduce 
new learning technology, highlight potential 
risks and corrective actions needed. 

 

 Preserve Integrity: Generate audit trail with one 
click to track where each requirement has been 
addressed. 

 

Training Plan Creation: Setup Lessons, assign 
and rearrange Lessons and Objectives with ease 
using a drag and drop function. 

 Speed Report Generation: Produce Objective and 
Media Analysis, Cost Analysis, Training Plans and 
dozens of reports in a single click. 

 

 

 

 

 

 

 

 

 

 
 

1.3 System Requirements 
 
Database/Server Minimum Requirements 

ü 2 CPU Processor with 4GB of RAM 
ü 5 GB of free Hard Disk Space 
ü Windows 2000, 2003, 2008, 2012 R2, 2016, 2019, 7, 8, 8.1, 10, NT, or Sun Solaris 9.0 or higher, or 

Linux Red Hat 6.0 or higher 
ü Web Server that supports Java Virtual Machine and can run Java Servlet.  Supported products include: 

Tomcat 4.0 or higher, IBM WebSphere 4.0 or higher, Resin, Oracle Application Server, Jserv and 
ƻǘƘŜǊǎΧ 

ü Oracle version 9i, 10g, 11g, 12c, 18c or 19c 
 
Workstation/Desktop Minimum Requirements 

ü Pentium IV with 512 MB RAM 
ü 200 MB of free Hard Disk Space 
ü Windows 98, ME, XP, VISTA, 7, 8, 10,  NT, 2000, 2003, 2008, 2012 R2, 2016, 2019 or Oracle Solaris 9.0 

or higher or Linux Red Hat 6.0 or higher 
ü Internet Explorer 6.0 or higher, Microsoft Edge, Mozilla Firefox 3.0 or higher, Google Chrome, or Safari 

Live Fire Review identified £140 
million in savings over 10 years 

 
UK Army  

 

LVC TS study identified $49.3 million 
in savings over 10 years 

 
Canadian Army  
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1.4 Background Theory and Process 

 
There are multiple reasons for considering alternate options for the delivery training:   
 
1. Reduce costs without impacting outcomes.  The costs of a training program can be divided into 6 main 

categories, namely: Development, Hardware, Administrative, Management, Delivery and Support.  By 
computing and comparing the cost of plausible delivery options over the life of the course, the most 
economical blend can be identified. 
 

2. IƳǇǊƻǾŜ ŜƳǇƭƻȅŜŜǎΩ ǇŜǊŦƻǊƳŀƴŎŜ ŀƴŘ ǇǊƻŘǳŎǘƛǾƛǘȅΦ  Lƴ ƻǘƘŜǊ ǿƻǊŘǎΣ ǘƘŜ ǎƻƻƴŜǊ ŜƳǇƭƻȅŜŜǎ Ǝŀƛƴ ǘƘŜ 
prerequisite knowledge and skills needed to improve productivity and attain missions/goals (i.e., 
improve customer service, reduce costly errors, etc.), the sooner the organization can reap the 
benefits.  In this case, by computing and comparing the time needed to attain proficiency, the venue 
that can help us achieve goal in the shortest period of time can be identified.   
 

3. Provide greater flexibility ς i.e., increase the number of individuals that can be trained in any given 
year with minimal ramp up time and cost. 
 

4. Minimize burden on operational units ς i.e., minimize on-the-job training requirements.  
 

5. Provide just-in-time training ς i.e., on-the-job performance support systems to enable employees with 
minimal experience to perform procedural, low risk tasks.   
 

6. /ƻƳōƛƴŀǘƛƻƴ ƻŦ ǘƘŜ ŀōƻǾŜ Χ  
 
Identifying the optimal blend of delivery options is not a simple exercise. Dozens of factors can impact the 
results.  Moreover, although some delivery options may appear advantageous under certain conditions, 
their added value can quickly vanish should the environment change ς for example, an increase/decrease 
in trainees to instructor ratio, availability of practice equipment, etc.  To identify the right blend of delivery 
options, the following model is proposed which can be easily configured to meet specific needs.  
 
 
Step 1. Classify Course Content 
 
In many cases, a blended approach is the most cost-effective training option.  For example, to train staff 
on the operation or maintenance of a System, the theory can be delivered through self-directed Computer 
or Web Based Training, and the hands-on elements using the System or Simulator/Trainer.  To uncover 
plausible delivery options, first, we should classify the course content (Learning Objectives or Teaching 
Points) according to their outcome (i.e., Knowledge, Skill or Attitude) and Learning Levels (for example, 
Fact, Rule, Procedure, Discrimination or Problem Solving).  Next, to minimize the analysis effort without 
compromising its integrity, Learning Objectives with similar characteristics (i.e., outcome and level) can 
be assigned to a single Group.  For example, Knowledge Learning Objectives that deal with Facts can be 
assigned to Group #1, while Knowledge Learning Objectives that require Problem Solving skills can be 
assigned to Group #5.  Since Learning Objectives within each Group are similar, the analysis time can be 
minimized without compromising its integrity by analyzing Groups as single entities (versus analyzing each 
Learning Objective separately) as outlined in Steps 2 to 5 below. 
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                                                                                For Each Group 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Step 2. Identify Viable Delivery Options [Media Analysis] 
 
The primary objective of this step is to identify delivery options that adequately meet organizational, 
ƭŜŀǊƴƛƴƎΣ ŀƴŘ ƭŜŀǊƴŜǊǎΩ ƴŜŜŘǎΦ  hǇǘƛƻƴǎ ǘƘŀǘ Řƻ ƴƻǘ ƳŜŜǘ ŀ ŎǊƛǘƛŎŀƭ ǊŜǉǳƛǊŜƳŜƴǘ ŀǊŜ ŜƭƛƳƛƴŀǘŜŘΣ ŀƴŘ ǘƘŜ 
rating of remaining options is reduced when a desired requirement is not met.  Whenever possible, 
supplements that address shortcomings and in-turn improve the viability of delivery options are 
proposed.  
  

Step 4. 

 

Forecast Direct and Indirect 
Costs  

Step 5. 

 

Rate Viable Delivery Options 

Step 3. 

 
Estimate Development Time  

Step 2. 

 

Identify Viable Delivery 
Options 

Step 7. 

 

Determine the Right Blend 
of Delivery Options 

Step 6. 

 
Assess Risk & Compute 

Hidden Costs  

Step 1b. 

 
Group Objectives 

Step 1a. 

 

List Learning Objectives 



Chapter 1 ï Getting Started 

____________________________________________________________________________________________ 

 

6 | P a g e 
www.bnhexpertsoft.com  

Copyright © BNH Expert Software Inc. 

Step 3. Estimate the Development Time 
 
Time needed to design and develop the content for each delivery option is estimated based on the 
complexity of the learning objectives, instructional strategies, multimedia and interaction requirements, 
available technology, experience of design and management team as well as quality of existing material. 
 
 
Step 4. Forecast Direct and Indirect Costs [Cost Analysis] 
 
All training course/program costs can be captured.  These include design/development, equipment/ 
hardware, administrative, management, delivery, maintenance and support.  Costs that impact budget 
(such as travel, hotel, meals, consulting fees, etc.) can be classified as Direct; and those that impact in-
house resources (developers, instructors, etc.) and productivity (such as time employees spend in training, 
lost opportunity, etc.) can be classified as Indirect. 
 
 
Step 5. Rate Plausible Delivery Options [Module Summary] 
 
Two criteria may be used for rating plausible delivery options: 
 
ü aƻǎǘ 9ŎƻƴƻƳƛŎŀƭ hǇǘƛƻƴΦ  wŀǘŜǎ ŘŜƭƛǾŜǊȅ ƻǇǘƛƻƴǎ ǘƘŀǘ ƳŜŜǘ ƻǊƎŀƴƛȊŀǘƛƻƴŀƭΣ ƭŜŀǊƴƛƴƎ ŀƴŘ ƭŜŀǊƴŜǊǎΩ 

needs (Step 2. Media Analysis) from least to most expensive.  
 

ü aƻǎǘ /ƻǎǘ 9ŦŦŜŎǘƛǾŜ hǇǘƛƻƴΦ  wŀǘŜǎ ŘŜƭƛǾŜǊȅ ƻǇǘƛƻƴǎ ǘƘŀǘ ƳŜŜǘ ƻǊƎŀƴƛȊŀǘƛƻƴŀƭΣ ƭŜŀǊƴƛƴƎ ŀƴŘ ƭŜŀǊƴŜǊǎΩ 
needs (Step 2. Media Analysis) according to their cost effectiveness ratio ς i.e., from most to least cost 
effective.  

  
 
Step 6. Assess Organizational Readiness for New Technology [Risk Analysis] 
 
hǊƎŀƴƛȊŀǘƛƻƴΩǎ ŜȄǇŜǊƛŜƴŎŜΣ ǊŜŀŘƛƴŜǎǎ ŀƴŘ ŀǘǘƛǘǳŘŜ ǘƻǿŀǊŘǎ ƭŜŀǊƴƛƴƎ ǘŜŎƘƴƻƭƻƎȅ Ŏŀƴ ƛƳǇŀŎǘ ǘƘŜ 
effectiveness as well as the costs of implementing a delivery option.  Successful implementation of a new 
learning technology may require retraining of development, delivery and support staff, changes to 
policies, procedures, support system, infrastructure and daily operation as well as the development of a 
communication and change management plans.  The impact of these changes ς often referred to as 
hidden costs ς is computed in this section. 
 
 
Step 7. Determine the Right Blend of Delivery Options [Course Summary] 
 
ADVISOR automatically identifies the most cost effective blend of delivery options (i.e., option with 
highest rating within each Group ς Step 5.), and computes its overall costs ς including direct, indirect and 
hidden (Step 6.).  Analysts can, of course, explore alternate blends and compare to the option 
recommended by ADVISOR as well as the status quo.   
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1.5 Getting Started 
 
To log on to ADVISOR Enterprise, go to http://www.bnhexpertsoft.com, click ƻƴ άLog inέΣ ƛƴǇǳǘ ȅƻǳǊ 
Username and Password, and click [Login].  A Popup Window with step by step instructions is presented 
to familiarize you with ADVISOR.  You may change your username, password and preferences by clicking 

on the Preferences node under the [Personalize] tab, editing the required items and clicking [Save]. 

For example, you may hide or display the Popup Window under the [Options] tab under the 
Preferences node by placing or removing the checkmark next to the ADVISOR Tour field and clicking 
[Save].  Context sensitive online help is also available for each field by clicking on [Help].  
  
 
 

 
 
 
To analyze a new course, click on the [Design] tab.  Two approaches may be used to analyze a Course.   
 
Preliminary Analysis: To quickly assess the feasibility and potential savings that may result from using 

alternate delivery options. This approach is highly effective in analyzing courses with single 
learning outcome.  Key data is collected under the Data Collection Wizard and 
submitted for analysis.  This approach (a) is simple to use, (b) assesses the potential for 
alternate delivery options within few minutes, and (c) analysis can be easily refined under 
the Course Analysis folder. 

 
Detailed Analysis: To assess the feasibility of using alternate blends of delivery options. This approach is 

recommended for courses with multiple learning outcomes.  To facilitate the forecasting of 
development, hardware, administrative, management, travel, instructors, facilities, 
transmission, maintenance and support costs; Templates and Resources can be created.  In 
addition to speeding the analysis, Templates and Resources preserve consistency in cost 
estimates among analystsΣ ŀǎ ǿŜƭƭ ŀǎ ŦŀŎƛƭƛǘŀǘŜ ŎŀǊǊȅƛƴƎ ƻǳǘ ƳǳƭǘƛǇƭŜ άǿƘŀǘ ƛŦ ǎŎŜƴŀǊƛƻǎέΦ  
Detailed analysis is conducted under the Course Analysis folder. 

 

http://www.bnhexpertsoft.com/
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1.6 How is ADVISOR Organized? 
 
ADVISOR has five main components organized within 3 windows (top, left and right ς the sizes of the 
windows can be adjusted by dragging the border). Once you become familiar with these components, the 
system operation and navigation will become fairly simple.  
 

a) Basic Functions (top window) ς Actions available to user are presented at the top of the screen.  You 
can Add, Save, Copy, Delete, Merge, Diverge, add comments/assumptions to a screen (Notes), Print a 
screen, Return to previous level (Up), Restore previous values, display context sensitive Help or 
Logout.  Information is only saved when you click [Save].  

 

b) Path (top window) ς Tracks your progress as you navigate through ADVISOR.  
 

c) Tree (left window) ς Lists options (nodes) available to user.  To expand an option (node), click on the 
[¤] icon.  To view the contents of an option (node), click on corresponding node. 

 

d) Tabs (top of right window) ς Data for some nodes are divided into several tabs.  Click on tab to view 
its contents. 

 
e) Main Window (right window) ς Content of each screen is presented in this window. 
 

 
 

 
 
  

c 

e 

a 

d 
b 
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1.7 Basic ADVISOR Functions 
 
Add: To add a Project, Mission, Job, Task, Objective, Course or any other element: 
Step 1: Click on corresponding folder (Projects, for example). 
Step 2: Click on [Add].   
Step 3: Input the desired info.   
Step 4: Click [Save].   
 
 
 

 
 
 
 
Edit: To edit a Project, Mission, Job, Task, Objective, Course or any other element: 
Step 1: Click on corresponding element (Project A, for example). 
Step 2: Modify the desired info.   
Step 3: Click [Save].   
 
 
  

1 

2 4 

3 
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Delete: To delete a Project, Mission, Job, Task, Objective, Course or any other element: 
Step 1: Place checkmarks next to the desired records (Project Management Office, for example). 
Step 2: Click [Delete].   
 
 
 

 
 
 
 
Track Changes: To find out when an element was created, modified or deleted and by whom, click on the 

View History  icon to display relevant data. 
 

 
 
 
 
  

1 

2 
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Edit Multiple Records: To edit multiple Projects, Missions, Jobs, Tasks, Objectives, Courses or any other 
elements: 
Step 1: Click on the corresponding folder.  
Step 2: Click the Edit All  icon.   
 

 
 
 
The Projects, Missions, Jobs, Tasks, Objectives, Courses, and so forth are presented in an Excel like tabular 
format.  You may sort the data on any column (Title, for example), or lock (prevent the column from 
scrolling), by clicking on the arrow to the right of the column title, and selecting desired option. To edit a 
field, click on the field, input or select option.  Once the desired fields/records are edited, click on [Save] 
to save all changes.  
 

 
 

1 

2 
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Modify Hierarchy: To change the hierarchy or the order of Tasks or Objectives:  
Step 1: Click on the corresponding folder.  
Step 2: Click the Edit Tree  icon.  
 

 
 
 

Tasks or Objectives are presented in a tree like structure. To change the hierarchy or order, simply drag 
and drop the tasks or objectives to the desired locations.  All links to Missions, Jobs, Objectives, Courses, 
etc.; as well as attributes including Knowledge, Skills, Attitudes, References and so forth are preserved. 
CƻǊ ŜȄŀƳǇƭŜΣ άtŜǊŦƻǊƳ Ǌƛǎƪ ŀƴŀƭȅǎƛǎέ ǎǳō ǘŀǎƪ Ƴŀy be dragged under the Tasks folder to become a Task.  
Moreover, all its links and attributes will remain intact. You may also view and edit the attributes of any 
Task or Objective by right clicking on the Task and selecting the Edit option.  Once record is edited, click 
on [Save] button above the record to save; and the [Save Tasks] button to save hierarchy changes.  
 
 
 

 

1 

2 
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Search and Copy:  You can search and copy Jobs, Tasks and Performance Objectives as follows: 
Step 1: Click on the desired folder ς Job Analysis, Tasks Analysis or Performance Objectives. 
Step 2: Click on the [Search] tab.   
Step 3: Select the desired search criterion and click [Save] ς more options may be provided ς to display 

available elements.  

 
 

 

 
 
Step 4: Select the desired item to copy data from and click [Save].  
 
 

 
 
Step 5: Place checkmarks next to the desired elements (Tasks, for example) and click [Save] to copy the 

elements (Tasks) including attributes and sub elements (Sub Tasks).   
 
 

 
  

1 

2 

3 

3 

4 

4 

5 

5 
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Import Data:  Dozens of Excel Spreadsheets are provided (http://www.bnhexpertsoft.com/data-
collection-forms-training-design-version-12/) to simplify and speed offline data collection from Subject 
Matter Experts (SMEs). The attributes and options within each form (Job Tasks, for example) are identical 
to the corresponding (Job Tasks) fields within ADVISOR.  Once completed, the data can be uploaded to 
ADVISOR Enterprise with a few mouse clicks, as follows: 
 

Step 1:  Click on the folder where data should be imported.  Please note that each spreadsheet is designed 
to import data under a specific folder within ADVISOR Enterprise.  For example, the Mission Tasks 
spreadsheet is designed to import Tasks under Missions, while the Job Tasks spreadsheet is 
designed to import Tasks under Jobs. 

 

Step 2: Click on the [Import] tab.   
 

Step 3: Click [Browse] and select the desired spreadsheet. 
 

Step 4:  Row on which data import should start, should be specified in the Start From Row field.  The top 
4 rows in ADVISOR Excel spreadsheets are reserved for headings and instructions.  Collected data 
typically starts on the 5th row. 

  

Step 5:  Indicate where the data for each field resides within the Excel spreadsheet.  For example, if Task 
Title is stored in column 1, then input 1; and so forth.  Data in Excel spreadsheets is sequentially 
mapped to corresponding fields in ADVISOR.  You are not required to import all attributes.  For 
example, if the Status and Task Classification attributes are not required, do not input column 
numbers for these fields.  ADVISOR will not import data for attributes that have not been assigned 
a column number. 

  

Step 6: Click on [Save] to import.   
 
 

 
 

Note:  Reference Code is also used for detecting duplicate records.  For example, if Job Task is imported, 
ADVISOR will 1st verify whether the Job already has a Task with the same Reference Code.  If it does, the 
ŦƻƭƭƻǿƛƴƎ ƳŜǎǎŀƎŜ ǿƛƭƭ ŀǇǇŜŀǊ ά5ǳǇƭƛŎŀǘŜ wŜŎƻǊŘǎ ŀƭǊŜŀŘȅ ŜȄƛsǘΦ hǾŜǊǿǊƛǘŜ ŀǘǘǊƛōǳǘŜǎΚέ  LŦ hƪ ƛǎ ǎŜƭŜŎǘŜŘΣ 
the attributes of the Job Task in ADVISOR will be updated.  If Cancel is selected, the import will be aborted.  

1 

2 

4 

5 

6 

3 

http://www.bnhexpertsoft.com/data-collection-forms-training-design-version-12/
http://www.bnhexpertsoft.com/data-collection-forms-training-design-version-12/
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Setup and Assign Meta Tags:  To minimize duplication each time a Mission, System or Project Task is 
added, it is stored in a centralized repository.  The Tasks can, in-turn, be assigned to any Mission or System 
by clicking on the [Select] tab, placing checkmarks next to desired Tasks and clicking [Save].   
 
 

 
 
Similarly, Knowledge, Skills and Attitudes (KSAs) are stored in a centralized repository and can be assigned 
to any Task or Objective.  
 
To quickly zero in on desired Tasks or KSAs within a repository, Meta Tags can be created under the Project 
Knowledge/Skills Attribute folder and assigned to any Task or KSA by clicking on [Meta Tag] tab, selecting 
the desired Meta Tags and clicking [Save]. 
 
 
 

 
 
  

1 

2 

3 

1 

3 
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Specify Items per Page:  By default, 10 items (such as Projects, Tasks, Objectives, Knowledge/Skills, and 
so forth) are displayed on each page.  Once the number of items exceeds 10, the remaining items are 
displayed on subsequent pages.  The number of pages available for each item is indicated on the top right 
as shown below.  To display the items within each page, click on the corresponding page number.  
 

 
 
 
 
You can modify the number of items to be displayed on each page under Options tab for the Preferences 
node under the Personalize tab by specifying the number of items to be displayed on each page and 
clicking [Save].  
 
 
 

 
 
  

2 

1 



Chapter 1 ï Getting Started 

____________________________________________________________________________________________ 

 

17 | P a g e 
www.bnhexpertsoft.com  

Copyright © BNH Expert Software Inc. 

Limit Access to Data/Analysis: By default, when a new Project, Job, Task, and so forth is created, its Status 
is set to Public to permit other Users to find, copy and reuse the Project, Job or Task using the Search 
function and in-turn minimize the effort needed to conduct the analysis.  This does not imply that other 
Users can review and edit your Project, Job or Task.  It simply implies that they can reuse.  To maintain 
anonymity, you can set the Project, Job or Task Status to Private, and in-turn exclude them from the 
Search function. 
 

 
 
 
 
Collaborate with Team:  Each analysis including Project, Course and so forth is assigned to a specific User 
(Manager) ς typically the individual that created the Project or Course.  By default, only the Manager can 
view the Project or Course and make changes.  To allow other Users to review and make changes, the 
Project or Course can be shared with them by clicking on the [Sharing] tab, placing checkmarks next their 
name and clicking [Save].  If the Project or Course Manager reports to another User, the Project or Course 
will be automatically shared with them.  In this case, the checkmark next to the Supervisor name is 
presented in read only mode.  
 

 
 

 
 
  

1 

2 
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Add Notes:  Users may add a Note to any screen by clicking on [Notes], typing the note in the new window 
and clicking [Save].  Notes from other Users are presented in read only mode in the bottom of the window.  
Users can only edit or delete their own Notes. 
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1.8 Learning ADVISOR 
 
To use ADVISOR, you should know how to perform basic computer, Windows and Browser operations.  
For example, how to start and quit applications, select commands and dialog box options.  To facilitate 
the learning process, ADVISOR comes with its own set of online tools.  These include: 
 
ü Online Tour: ŀ ǎƭƛŘŜ ǎƘƻǿ ǘƘŀǘ ƘƛƎƘƭƛƎƘǘǎ !5±L{hwΩǎ Ƴŀƛƴ ŦŜŀǘǳǊŜǎΦ  Lǘ ƛǎ ǇǊŜǎŜƴǘŜŘ ŀŦǘŜǊ ¦ǎŜǊ ƭƻƎǎ ƻƴ 

ADVISOR.  You can hide and redisplay by unchecking or rechecking the ADVISOR Tour field under the 
[Options] tab, under the Preferences node under the Personalize tab and clicking [Save]. 
 

ü Video Clips to gain a better understanding of ADVISORΩs main functions and features.   To view, please 
visit the following: http://www.bnhexpertsoft.com/how-to-video-overview/ .  
 

ü Step-by-Step Guides for configuring ADVISOR, as well as conducting mission analysis, system analysis, 
competency analysis, job task analysis, media analysis, cost analysis, fidelity analysis, performance 
analysis, etc.  To view and download, please visit the following: http://www.bnhexpertsoft.com/user-
guides-version-12/.    
 

ü Answers to Frequently Asked Questions are available online at: http://www.bnhexpertsoft.com/faq-
1-install/.  
 

ü Context Sensitive Online Help can be displayed for each screen by clicking on [Help]. Context sensitive 
video clips are also embedded throughout ADVISOR and can be viewed by clicking on the video 

 icon.  
 

ü Basic Excel Data Collection Forms for various ADVISOR data elements along with data import 
instructions are available online at: http://www.bnhexpertsoft.com/data-collection-forms-training-
design-version-12/.   
 

ü Detailed Excel Data Collection Forms for Project Tasks, System/Competency Tasks and Job Tasks 
along with data import instructions are available online at: http://www.bnhexpertsoft.com/detailed-
data-collection-forms-version-12/.   
 

ü Sample Reports from each module are available online at: http://www.bnhexpertsoft.com/reports/.  
 

ü Technical Support:  Available 8:00 am to 6:00 pm EST by calling 1 (514) 745-4010.  You may also fax 
your questions to 1 (514) 745-4011 or E-mail to support@bnhexpertsoft.com. 

 
 

  

http://www.bnhexpertsoft.com/how-to-video-overview/
http://www.bnhexpertsoft.com/user-guides-version-12/
http://www.bnhexpertsoft.com/user-guides-version-12/
http://www.bnhexpertsoft.com/faq-1-install/
http://www.bnhexpertsoft.com/faq-1-install/
http://www.bnhexpertsoft.com/data-collection-forms-training-design-version-12/
http://www.bnhexpertsoft.com/data-collection-forms-training-design-version-12/
http://www.bnhexpertsoft.com/detailed-data-collection-forms-version-12/
http://www.bnhexpertsoft.com/detailed-data-collection-forms-version-12/
http://www.bnhexpertsoft.com/reports/
mailto:support@bnhexpertsoft.com
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Chapter 2: Setup Course and Classify Content 
 
 

2.1 Introduction 
 
Two approaches can be utilized to perform a Media Analysis within ADVISOR: Preliminary Course Analysis 
or Detailed Course Analysis.    
 
Preliminary Course Analysis uses the Data Collection Wizard to quickly assess the feasibility and potential 
savings that may result from using alternate delivery options. This approach is highly effective in analyzing 
courses with a single learning objective/outcome.  Key data is collected under the Data Collection 
Wizard and submitted for analysis.  Preliminary Course Analysis is simple to use, assesses the viability for 
alternate delivery options within few minutes, and the analysis can be easily refined as needed under the 

Course Analysis folder.  In other words, Preliminary Course Analysis is best suited for quick analysis of 
courses with limited details and single learning outcome.  
 
Comparatively, Detailed Course Analysis provides a more comprehensive analysis of course content to 
assess the feasibility of using alternate blends of delivery options. This approach is better suited for 
courses with multiple learning objectives/outcomes.  To facilitate the forecasting of development, 
hardware, administrative, management, travel, instructors, facilities, transmission, maintenance and 
support costs, Templates can be created and made available to all analysts.  In addition to speeding the 
analysis process, Templates preserve ŎƻƴǎƛǎǘŜƴŎȅΣ ŦŀŎƛƭƛǘŀǘŜ ŎŀǊǊȅƛƴƎ ƻǳǘ ƳǳƭǘƛǇƭŜ άǿƘŀǘ ƛŦ ǎŎŜƴŀǊƛƻǎέ as 
well as capture the number and type of personnel and resources needed.  Detailed Course Analysis is 
carried out under the Course Analysis folder. 
 
Step by step process for conducting Detailed Course Analysis as well as Preliminary Course Analysis are 
presented in this user guide.  Separate Step-by-Step Guides are also available for conducting Preliminary 
Course Analysis using the Data Collection Wizard, and Detailed Course Analysis.  For info on basic 
functionality and how to configure ADVISOR in line with needs, please refer to the Configure ADVISOR 
Step by Step or User Guide.  Remember that context sensitive help for each screen is also available by 
clicking on [Help]. 
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2.2 Setup Program 
 
Courses or training activities can be organized under Programs.  A Program can be job centric ς i.e., 
includes all courses required by a specific job/role; platform centric ς i.e., includes all courses required to 
operate, maintain and support a specific aircraft, ship or vehicle; client centric ς i.e., includes all courses 
required by a specific client; school centric ς i.e., includes all courses delivered at a specific school; and so 
forth.   To setup a new program: 
 

Step 1: Click on the Programs folder.   
Step 2: Click [Add]. 
Step 3: Input program title, reference code and sequence. 
Step 4: Click [Save]. 
 

 
 

 
 
 
2.3 Setup New Courses 
 
To identify the most cost effective training venue that meets ƻǊƎŀƴƛȊŀǘƛƻƴŀƭΣ ƭŜŀǊƴƛƴƎ ŀƴŘ ƭŜŀǊƴŜǊǎΩ ƴŜŜŘǎΣ 
begin by creating courses or training activities. To create a new course: 
 

Step 1: Click on the Course Analysis folder.   
Step 2: Click [Add]. 
Step 3: Input course title, expected life of course, start and end dates and other required information. 
Step 4: Click [Save] once all relevant fields are completed, to create. 
 
 

 

 
 

1 

2 4 

3 

1 

2 
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Notes:   
 

ü You may share your analysis with colleagues (i.e., Users assigned to the same Client) by clicking on 
[Sharing] tab, placing checkmarks next to their names and clicking [Save]. 
 

ü You may link the Course to Jobs, Systems/Competencies or Missions/Goals that have been setup 
under the [Analyze] tab by selecting Job, System/Competency or Mission/Goal under the Link to field.  
Based on this selection, the Target Audience for this course (Section 2.4) will vary accordingly. 
 

ü Course or training activity can also be classified as Individual Training or Collective Training under the 
Training Classification field.  Individual Training focuses on the Knowledge/Skills/Attitudes needed to 
perform specific Tasks; and Collective Training on the Tasks that individuals/units are required to 
perform to achieve missions/goals.  If Individual Training is selected, the Course Learning Objectives 
can be linked/derived from Knowledge/Skill/Attitude needed to perform Tasks ς as outlined in Section 
2.4. If Collective Training is selected, the Course Learning Objectives can be linked/derived from the 
Performance and Enabling Objectives needed to perform Tasks (Section 2.4).  
 

ü Two venues may be used for forecasting training costs:  
 

Ç Standard. Relies on averages to forecast development, hardware, admin, management, 
instructors, facilities and support costs.  For example, if multiple personnel (project manager, 
instructional designer, graphic artist, etc.) are needed for content development, then the average 
daily cost of the group is used to forecast development costs.   
 

Ç Detailed. Uses specific personnel, equipment, facility and material costs to forecast development, 
hardware, admin, management, instructors, facilities and support costs.  For example, if multiple 
personnel (project manager, instructional designer, graphic artist, etc.) are needed for content 
development, then the time and cost of each individual is used to forecast development costs.  

 
ü Once the analysis is completed or a milestone is reached, the course analysis can be archived ς i.e., 

preserved.  Once archived, changes to the current analysis will not impact archived data.  To archive 

an analysis, click on the (course) node, then click on the [Archive] tab, input the Version Title and 
click [Save].  The date on which the archive was created is automatically saved.   
 

A list of archived versions is presented under the [View] tab. You may view an archived version in read 
only mode, delete as well as recover (i.e., overwrite existing version).  Of course, if a Course is deleted, 
all archived versions of the Course will be automatically deleted as well.  
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Move Courses between Programs 
 

To move courses between programs: 
 

Step 1: Click on the Manage Courses node.   
 

 
 
 

New window that displays Courses within each Program is presented. To move Courses from Procurement 
and Contracting program to Project Management program: 
Step 2:  Drag & drop Courses from Procurement & Contracting folder into Project Management. 
Step 3:  Click [Save].  
Step 4:  To return to ADVISOR, close the Report window. 
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2.4 Identify Target Audience and Trainees per Year 
 

Step 1:  To select the audience for the course, click on ¤ next to the (course title) node to expand and 
click on Target Audience folder.   

  

Note:   Missions or Systems folder in lieu of Target Audience may appear if Mission or 
System was selected under the Link To field.  

 
Step 2:  Place checkmarks next to the appropriate Jobs (Positions).  
Step 3:  Click [Save]. 
 

 
 

 
 
Notes:   

 

ü Based on option selected under the Link to field (Section 2.3), Jobs, Systems/Competencies or 
Missions that have been setup under the [Analyze] tab, will be presented. In the above example, άJobέ 
was selected under the Link to field. 
 

ü If Jobs, Systems, Competencies or Missions/Goals have not been defined under the [Analyze] tab, the 
Target Audience, Missions or Systems folders will not be presented. 
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Once the Target Audience is selected, corresponding folders will appear, Project Manager for example, 

under the Target Audience folder. Moreover, the characteristics and the financial data of selected Jobs 

will be automatically imported under the Instructional Design Factors node and the Cost Factors 
node, respectively.  This data may in-turn impact the viability and costs of plausible delivery options.    
 
Furthermore, Learning Objectives (Teaching Points) for each Performance and Enabling Objective created 
under the [Analyze] tab for the selected Job, System/Competency or Mission/Goal are also presented 

under the Link Training to Knowledge/Skill Gaps node to enable analysts to identify gaps that will be 
addressed in this Course.  To link the Course to Knowledge/Skill Gaps: 
 

Step 4: Click on ¤ next to the selected Target Audience for the Course, Project Manager for example. 

Step 5: Click on Link Training to Knowledge/Skill Gaps node. 
Step 6: Select the Learning Objectives (Teaching Points) to be covered in this Course.  

Step 7: Click [Save] to copy sŜƭŜŎǘŜŘ [ŜŀǊƴƛƴƎ hōƧŜŎǘƛǾŜǎ ǳƴŘŜǊ ǘƘŜ /ƻǳǊǎŜΩǎ Learning Objectives folder. 
 

 

 

 
 
 
 
Notes: 

 

ü Link Learning Objectives to POs/EOs node is used to map Learning Objectives (Teaching Points) 
within existing courses to Performance and Enabling Objectives within Jobs, Systems, Competencies, 
Mission or Goals, if such links do not exist.  In other words, to indicate how the content of an existing 
course supports operational requirements. In addition to identifying Learning Objectives (Teaching 
Points) that are not aligned with Tasks and Sub Tasks, additional training requirements can be 
identified ς i.e., Tasks or Sub Tasks not supported by current Learning Objectives (Teaching Points).  
This is accomplished by dragging and dropping the Course Learning Objectives (Teaching Points) from 
the left column under the corresponding Performance or Enabling Objectives in the right column.  
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ü If Collective versus Individual is selected under the Training Classification field (Section 2.3), Link 

Training to POs/EOs node will be presented in lieu of Link Training to Knowledge/Skill Gaps to 
identify the Performance and Enabling Objectives that will be addressed in this Course. Moreover, the 

Link Learning Objectives to POs/EOs is no longer relevant and will not be presented. 
 

ü If more than one Job is selected the Target Audience folder, the characteristics and financial data 
of selected Jobs is combined in accordance with option selected under Criterion for Combining Data 

field under the  (course) node, as follows:  
 

Ç Lowest Common Denominator ς i.e., worst-case scenario.  If Internet Connection Speed for 1st Job 
is 28,000bps & 2nd Job is 56,000bps, then the Internet Connection Speed will be set to 28,000bps.   
 

Ç Average Value.  If Internet Connection Speed for 1st Job is 28,000bps & 2nd Job is 56,000bps, then 
the Internet Connection Speed will be set to 33,000bps. 
 

Ç Highest Common Denominator ς i.e., best-case scenario.  If Internet Connection Speed for the 1st 
Job is 28,000bps & 2nd Job is 56,000bps, then Internet Connection Speed will be set to 56,000bps. 

 
ü If Target Audience Characteristics or Financial Data are updated under Job Analysis folder under 

the [Analyze] tab, you can re-import the latest data by clicking on Import Audience Characteristic 
node, selecting required items and clicking [Save]. 

 
 
To specify the number of individuals to be trained each year: 
 

Step 1: Click on the Trainees per Year node. 
Step 2: Input the number of trainees in each year.  
Step 3: Click [Save]. 
 

 
 

 
 
Notes: 

 

ü Years are generated by ADVISOR based on Course Start Date and expected Life, as specified under the 

(course) node, i.e. Project Management., for example. 
 

ü To specify the number of trainees per month, select the Months option under Estimate Number of 

Trainees in field under the (course) node.    

1 

2 
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2.5 Rules for Grouping Learning Objectives 
 
Although each Learning Objective (Teaching Point) can be analyzed separately to determine the most 
effective and economical training option, the process can quickly become cumbersome for courses with 
dozens of objectives.  To drastically reduce the analysis time without compromising its integrity, Learning 
Objectives (Teaching Points) with similar characteristics can be grouped and analyzed as a single 
entity.  The following rules should be followed when grouping Learning Objectives (Teaching Points): 
 
1st Rule:  Only Objectives with similar learning outcomes can be placed in the same Group.  For simplicity, 

the learning outcomes are divided into five primary categories (based on Benjamin Bloom, 1964, 
Taxonomy of Educational Objectives).   
 

Learning Outcome Definition 

Knowledge 
(Cognitive) 
 

Refers to the ability of individuals to recall, recognize, understand, translate and 
interpret information as well as use learned material in specific 
instances.  Select Knowledge as a primary learning outcome if the purpose of 
the learning objective is to enable personnel to name parts of an object, point 
out certain object, state definition, classify an object into a category, contrast 
two objects, apply theoretical knowledge to perform a task or use a particular 
set of procedures. 
 

Example 
ü Personnel will be able to explain and describe the rules and procedures for 

filing a complaint within the department. 

Mental Skills 
(Cognitive, Analysis)   

Refers to the ability of individuals to compare, contrast and break down a 
problem in order to arrive at a solution.  In other words, issues that involve 
thinking, reasoning, analyzing, judging and inferring.  Select Mental Skills as the 
primary learning outcome if the purpose of the learning objective is to provide 
personnel with the skills to select and organize alternatives, or derive solutions 
to a problem.   
 

Examples 
ü Personnel will be able to trouble shoot a piece of equipment.  
ü tŜǊǎƻƴƴŜƭ ǿƛƭƭ ōŜ ŀōƭŜ ǘƻ ŀƴŀƭȅȊŜ ŎƭƛŜƴǘǎΩ ŦƛƴŀƴŎƛŀƭ ƻōƧŜŎǘƛǾŜǎ ŀƴŘ ǇǊƻǇƻǎŜ 

an investment plan. 
ü Solve mathematical formula by combining previous learned rules. 

Psychomotor Skill 
(Manual or Physical 
Skills).   

Refers to the ability of individuals to perform a physical task.  A task that 
requires physical exertion or manipulation of an object.  In other words, tasks 
that require physical movement.  Skills are learned capabilities whose outcomes 
are demonstrated through speed, accuracy and quality of the performed 
task.  Select psychomotor Skill as a primary learning outcome if the purpose of 
the learning objective is to provide personnel with άpractical skillsέ or άmotor 
skillsέ that require perception, decision and action to perform the task.   
 

 Examples 
ü Personnel will be able to climb a telephone pole.  
ü Personnel will be able to repair a flat tire. 
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Attitude  
(Affective, Growth 
in Feelings or 
Emotions). 

Refers to individualsΩ personal beliefs and/or preferences towards an object, 
situation or person. In other words, their mental state that influences behavior, 
choices and opinions.  Select Attitude as a primary learning outcome if the 
purpose of the learning objective is to change, in some way, the attitudes, 
behavior, preferences and/or value systems of personnel.  
 

Examples 
ü Personnel will demonstrate positive attitudes and behaviors towards new 

work procedures. 
ü Personnel will be more sensitive to colleagues with varied cultural 

backgrounds. 

Software 

Refers to the ability of individuals to use a software application, an operating 
system, a legacy system or an information management system effectively and 
efficiently.  Learning a software application requires the use of both cognitive 
and psychomotor skills.  Select Software as a primary learning outcome if the 
purpose of the learning objective is to provide personnel with the knowledge 
and skills needed to use a software application and/or operating system. 
  
Examples 
ü Personnel will be able to type and format a letter.  
ü Personnel will be able to import charts into an MS Word document. 

 
The importance of learning outcomes in media selection can be illustrated through the following example. 
Driving rules (knowledge) may be learned using instructor-led or self-directed delivery options.  However, 
learning how to drive a car (psychomotor skill) can only be acquired through practice on a real or simulated 
car. 
 
2nd Rule:  Only Learning Objectives with similar characteristics should be assigned to the same Group.  For 

example, Knowledge Learning Objectives with similar levels of complexity that require similar 
instructional strategies, and have similar audio, video and interaction requirements should be 
placed in the same Group.     

  

To facilitate the process of identifying Learning Objectives with similar characteristics, in 
addition to Learning Outcomes, the Learning Level of each Learning Objective (Teaching Point) 
can be specified under classification field.  For example, Knowledge Objectives can be classified 
as Fact, Rule, Procedure, Discrimination or Problem Solving.  Since Learning Objectives within 
the same Level have similar levels of complexity, require similar instructional design strategies 
and (within a specific domain) have similar display, interaction and evaluation requirements; it 
can be reasonably assumed that Learning Objectives with similar Outcomes and Learning Levels 
(Knowledge ς Fact, for example) will have similar characteristics.    
 

Notes: 
 

In some cases, it may be desirable to combine Learning Objectives with different Learning Levels or 
ŎƘŀǊŀŎǘŜǊƛǎǘƛŎǎ ǿƛǘƘƛƴ ǘƘŜ ǎŀƳŜ DǊƻǳǇΦ  Lƴ ǘƘƛǎ ŎŀǎŜΣ ǘƘŜ DǊƻǳǇΩǎ ŎƘŀǊŀŎǘŜǊƛǎǘƛŎǎ ǎƘƻǳƭŘ Ŧƻƭƭƻǿ ŜƛǘƘŜǊΥ 

  

ü The dominant Learning Level; if the majority of Learning Objectives within the Group have specific 
Learning Level or characteristics; or 
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ü The most difficult Learning Outcome; if the Learning Objective has multiple Learning Outcomes 
(Knowledge and Skill, for example).  The hierarchy levels, from simple to most difficult are: 
Knowledge, Software and Mental Skills (Bloom 1964, Reiser & Gagné 1983, Gagné 1985).  
Although Attitude and Skill are categorized under different domains, since Attitude and Skill 
impose greater restriction on delivery options, ǘƘŜȅ ǎƘƻǳƭŘ ŘƛŎǘŀǘŜ ǘƘŜ DǊƻǳǇΩǎ [ŜŀǊƴƛƴƎ hǳǘŎƻƳŜΦ 
 

For example, in the absence of a knowledge component, the outcome of the Learning Objective 
άŎŀƭƛōǊŀǘŜ ŀ ǎȅǎǘŜƳέ ǎƘƻǳƭŘ ōŜ tǎȅŎƘƻƳƻǘƻǊ {ƪƛƭƭ ŜǾŜƴ ǘƘƻǳƎƘ ŀ ƪƴƻǿƭŜŘƎŜ ŎƻƳǇƻƴŜƴǘ ǘƘŀǘ 
explains how the system is calibrated may be present. 

 
 
Three examples are provided to further articulate how Learning Objectives should be grouped. 
 

Example #1 ς MS Word 
 

All Learning Objectives in the following MS Word course can be assigned to same group, and analyzed as 
a single entity.  
 

Learning Objective Outcome Classification Group 

Personnel will be able to: 
#1: Install MS Word. 

 
Software 

 
N/A 

 
1 

#2: Type and format a letter. Software N/A 1 
#3: Type and format a report. Software N/A 1 
#4: Conduct a mail merge. Software N/A 1 
#5: Import figures into a document. Software N/A 1 

 
 

Example #2 ς Interview Skills 
 

An interview skills course can be divided and analyzed in two Groups to identify the most cost-effective 
blend of delivery options. 
  

Learning Objective Outcome Classification Group 

Personnel will be able to: 
#1: List the benefits of using proper interviewing skills. 

 
Knowledge 

 
Fact 

 
1 

#2: Describe the five communication techniques. Knowledge Fact 1 
#3: Apply the five communication techniques during an interview. Knowledge Problem 

Solving 
2 

 
 

Example #3 ς Needs Analysis 
 

A needs analysis course can be divided and analyzed in two Groups to identify the most cost-effective 
blend of delivery options. 
 

Learning Objective Outcome Classification Group 

Personnel will be able to: 
#1: Explain the purpose of needs analysis. 

 
Knowledge 

 
Fact 

 
1 

#2: Explain the advantages of conducting needs analysis. Knowledge Fact 1 
#3: Describe and explain the steps in a needs analysis. Knowledge Fact 1 
#4: Successfully conduct needs analysis. Knowledge Problem 

Solving 
2 
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Notes: 
 

ü Learning Objective Outcome and Classification are highly dependent on the action verb that describes 
what individuals will be required to do.  Recommended verbs for Learning Outcomes/Levels are 
presented in Annex A of the Training Analysis User Guide. 
 

ü Groups have no bearing on how the training should unfold.  The order in which Learning Objectives 
should be presented and in which Lesson, is specified in the Training Plan. The primary objective of 
the Learning Objectives Groups is to minimize the analysis time without compromising its integrity.  

 
 

2.6 Create and Group Learning Objectives 
 

To create new Learning Objective: 
 

Step 1:  Click on the Learning Objectives folder.   
Step 2:  Click [Add]. 
Step 3: Input the learning objective title, length, learning outcome, classification and other required 

information. 
Step 4:  Click [Save] once all relevant fields are filled out, to create the Learning Objective. 
 

 
 

 
 
Notes:   

 

ü When Learning Objectives are selected under the Link Training to Knowledge/Skill Gaps node 
under the Target Audience folder (Section 2.4), selected Objectives including attributes are 
automatically copied under the Learning Objectives folder; and linked to corresponding Objectives 
under the [Analyze] tab.  In other words, should the attributes of Objectives under the [Analyze] tab 
change, they will automatically cascade to Learning Objectives under the Course, when the cascade 
option is turned on .  You may of course turn the cascade option off  to make changes to an 
Objective under the Course. 
 

1 
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ü Definitions for Learning Outcomes are presented under Section 2.5 and can be accessed online by 
clicking on [Help].  If a Learning Objective has more than one learning outcome, then it should either 
be divided into multiple Learning Objectives or the most dominant category selected. 
 

ü The Learning Level of each Objective can be specified under the Classification field to facilitate the 
grouping of Objectives with similar characteristics.  
 

ü To simplify and speed media analysis without compromising analysis integrity, Learning Objectives 
with similar outcome and characteristics can be analyzed as a single unit (Group).  The Group that 
each Learning Objective is assigned to is indicated in the Group field.  Learning Objectives can only be 
placed in Groups with similar learning outcomes.  That is, you may place all Knowledge Objectives 
within the same group, but cannot place Knowledge Objectives with Objectives that deal with Mental 
or Psychomotor Skills.  You may also analyze each Learning Objective separately, if you choose, by 
assigning each Learning Objective to a unique Group.  
 

ü To automatically assign Learning Objectives with similar Learning Outcome and Classification to the 
same Group, click on the [Auto Allocate] tab under the Learning Objectives folder, place 
checkmark next to Auto Allocate and click [Save].  Placing Learning Objectives with similar outcomes 
and characteristics in a single Group, will drastically reduce the analysis time without compromising 
its integrity.  In the example above, the results can be attained by conducting two analyses (one for 
each Group) instead of ten analyses (one for each Learning Objective).  
 

ü To view and analyze the Groups, click on the Group Analysis folder, and the ¤ next to it to expand 
(Section 4.4). 
 

ü To facilitate the creation of a Training Plan that outlines how training should unfold, Lessons can be 

created under the Lessons folder.  Lessons can also be created, deleted or rearranged under the

Training Plan node (Section 10.1).  Learning Objectives can be assigned to Lessons under the 

Training Plan node or (learning objective) node.   
 
 

2.7 A Final Note 
 

The complexity of the analysis will increase as the number of Groups increase.  Although a Course can be 
divided into 999 Groups, in most cases, Learning Objectives can be adequately analyzed within a few 
Groups.  Procedures for identifying the most cost effective training option for Learning Objectives within 
each Group are outlined in Chapters 4 to 8.  The results from all Groups are then combined (Chapter 9) to 
determine the right blend of delivery methods.  
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Chapter 3: Setup Course Instructional Design Factors & Costs 
 
 

3.1 Specify Course Instructional Design Factors 

 
To define instructional design factors that impact the entire content such as reasons for course, audience 
characteristics, limitations and consequences of errors:   
 

Step 1:   Click on the Instructional Design Factors node. 
Step 2: Input the required information under [Content], [Audience], [Limitations], [Hardware] and 

[Application] tabs. 
Step 3:   Click [Save] once all relevant Instructional Design Factors for the course have been defined.   
 

  
 

 
 
 
Notes:   

 

ü If Instructional Design Factor templates have been created (ADVISOR Configuration Guide, Section 
3.1), relevant template can be selected under the Template field, and imported by clicking [Save]. 
Since Templates can be assigned to multiple Courses, to preserve data integrity, should the Template 
attributes change, they automatically cascade to all corresponding Courses when cascade option is 
turned on .  You may of course turn cascade option off   to make changes to a Course. 
 

ü You do not have to answer all questions.  Recommendations are based on provided information.

1 
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3.2 Specify Course Cost Factors 

 
Costs that impact the entire content can be specified as follows: 
 

Step 1:  Click on the Cost Factors node.   
Step 2:  Input the required information under [Trainees], [Capability] and [Expectations] tabs. 
Step 3:  Click [Save] once all relevant Course Cost Factors have been defined.   
 

 
 

 
 
 
Notes: 

 

ü If Technical Capability templates have been created (ADVISOR Configuration Guide, Section 3.1), 
relevant template can be imported by clicking the [Capability] tab, selecting relevant template under 
the Template field and clicking [Save]. 
 

ü All costs can be classified as Direct [D] (impacts budget) or Indirect [I] (impacts personnel/resource 
requirements/productivity) by clicking on the corresponding [D] or [I] label to toggle between the two 
options. 

 
 
 

1 

2 

2 

3 



Chapter 3 ï Setup Course Instructional Design Factors & Costs 

____________________________________________________________________________________________ 

35 | P a g e 
www.bnhexpertsoft.com  

Copyright © BNH Expert Software Inc. 

 

3.3 Import Course Templates 
 
If Instructional Design Factors, Technical Capability or Transmission Costs Templates have been setup for 
the Client (ADVISOR Configuration Guide), all relevant templates can be imported at the same time, as 
follows: 
  

Step 1:  Click the Import Course Templates node.  
Step 2:  Select the desired Templates. 
Step 3:  Click [Save]. 
 
 

 
 
 
 

Step 4:  Click the hyperlink next to selected Template, to view or edit imported data.  For example, the 
Instructional Design Factors node will appear if the [Instructional Design Factors] hyperlink is 
clicked. 

 

 
 
Notes:   
 

ü Since Templates can be assigned to multiple Courses, to preserve data integrity, should the Template 
attributes change, they automatically cascade to all corresponding Courses when the cascade option 
is turned on .  You may of course turn cascade option off   to make changes to a Course.     
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Chapter 4: Identify Viable Delivery Options 
 
 

4.1 Introduction 
 
Each Group (i.e., Learning Objectives with similar characteristics) is analyzed separately to determine the 
most cost effective delivery option.  Since the primary objective of most training programs is to improve 
performance by imparting knowledge and skills needed to adequately perform tasks to the desired 
standard ς only media that can effectively deliver the required knowledge/skills should be considered.  
Otherwise, valuable resources will be wasted.  To assess the viability of available delivery options, Media 
Analysis (Step 2.) should be conducted. 
 
 

 
 
 
 
 
 
 
 
                                                                                 For Each Group 
  
                                       
                                                  

Step 1a. 

 

List Learning Objectives 

Step 1b. 

 

Group Objectives 

Step 2. 

 

Identify Viable Delivery 
Options 

Step 3. 

 

Estimate Development Time  

Step 4. 

 

Forecast Direct and Indirect 
Costs  

Step 6. 

 

Assess Risk & Compute 
Hidden Costs  

Step 5. 

 

Rate Viable Delivery Options 

Step 7. 

 

Determine the Right Blend 
of Delivery Options 
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4.2 Adult Learning Theory  
  
A brief review of basic adult learning theory principles and what we know for sure will put the Media 
Analysis model into perspective.  
 

Learning Styles 
 

Adult learners have a number of characteristics that set them apart from traditional K-12 and many 
ǳƴŘŜǊƎǊŀŘǳŀǘŜ ǎǘǳŘŜƴǘǎΦ  ¢ƘŜǊŜ ƛǎ ŀ ƎŜƴŜǊŀƭ ŎƻƴǎŜƴǎǳǎ ǘƘŀǘ ƭŜŀǊƴŜǊǎΩ ŜȄǇŜǊƛŜƴŎŜǎ ŀƴŘ ƳƻǘƛǾŀǘƛƻƴ ό.ǳƭƭŜƴΣ 
1998; Fisher, 1999) impact the effectiveness of the learning.  Moreover, it is estimated that 70% of adult 
learning is self-ŘƛǊŜŎǘŜŘ ό/ǊƻǎǎΣ мфумύ ŀƴŘ ƭŜŀǊƴŜǊΩǎ ƭŜǾŜƭ ƻŦ ŜŘǳŎŀǘƛƻƴ Ƙŀǎ ƳƛƴƛƳŀƭ ƛƳǇŀŎǘ ƻƴ ǘƘŜƛǊ ŘǊƛǾŜ 
to engage in self-directed learning (Tough, 1978; Sheckley, 1985).  According to Gagné (1985), the 
following events will greatly stimulate the adult learner and support the learning process: 
 

ü Gain learner attention ü Elicit a performance 

ü Inform learner of objective ü Provide corrective feedback 

ü Recall prerequisite learning ü Assess the performance; and 

ü Present stimulus material ü Enhance retention and transfer 

ü Provide learning guidance  

 
Moreover, evidence over the past 30 years suggests that learning style has minimal impact on learning 
(Coffield, Moseley, Hall & Ecclestone, 2004; Clark, 2003).  In other words, although individuals have 
learning preferences, many studies measuring the achievement of learners when they are taught 
according to their preferred method or non-preferred method failed to detect differences in the amount 
of learning. 
 
Differences in the environment can, on the other hand, impact the effectiveness of learning.  Instructional 
methodologies must vary in adult learning environments, otherwise boredom will result and motivation 
will drop.  Of course, there is no single instructional methodology, ideology, or philosophy of education 
that is effective in every situation (Fisher, 1999).  However, Knowles (1990) and Merriam & Brockett (1996) 
ƻŦŦŜǊ ǘƘŜ ŦƻƭƭƻǿƛƴƎ ƛƴǎƛƎƘǘǎ ƛƴ ŀŘǳƭǘ ƭŜŀǊƴŜǊǎΩ ǇǊŜŦŜǊŜƴŎŜǎΥ    
 

ü Direct their own learning 
ü Non-threatening learning environments. Adult 

learners take errors personally and let them 
affect their self esteem 

ü Identify their own learning goals 
ü Nonhuman media ς such as books, television 

and computers 

ü Practical applications ü Integrate new ideas in what they already know  

ü Straightforward approach ü Integrate new knowledge with prior knowledge 

ü Comfortable learning environment ς both 
physical and psychological 

 

 
Learning Relevance 
 

Hummel (1993) indicated that adult learners require authenticity from their education.  Providing real-
world problems with appropriate levels of complexity are a must for adult learners (Reigleluth, 1983; Kolb 
1984 & 1998; Whitehead, 1988; Savery & Duffy, 1996).    
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4Φо !5±L{hwΩǎ DǳƛŘƛƴƎ tǊƛƴŎƛǇƭŜǎ 
 
Since studies in adult learning theory suggest that effective instructional design strategies that stimulate 
learners, support learning process, include real world problems, etc., as well as the environment have a 
great impact on the effectiveness of learning, we can conclude that as long as the delivery option (media) 
can accommodate the desired instructional design strategies and the learning environment is adequate, 
ǘƘŜ ƳŜŘƛŀΩǎ ƛƳǇŀŎǘ ƻƴ ƭŜŀǊƴƛƴƎ ƻǳǘŎƻƳŜ ǿƛƭƭ ōŜ ƳƛƴƛƳŀƭΦ  ¢Ƙƛǎ ŎƻƴŎƭǳǎƛƻƴ Ƙŀǎ ōŜŜƴ ŎƻƴŦƛǊƳed by Russell 
όнллмύ ƻŦ bƻǊǘƘ /ŀǊƻƭƛƴŀ {ǘŀǘŜ ¦ƴƛǾŜǊǎƛǘȅ ƛƴ Ƙƛǎ ōƻƻƪ ά¢ƘŜ bƻ {ƛƎƴƛŦƛŎŀƴǘ 5ƛŦŦŜǊŜƴŎŜ tƘŜƴƻƳŜƴƻƴέΦ  Lƴ ƛǘΣ 
Russell challenges the criticism of traditional educators that distance learning is inferior to classroom 
study.  Through 355 research reports, papers, and summaries (from 1982 to 1998), Russell disproves this 
criticism and demonstrates that technology-based distance education generates similar outcomes as the 
classroom experience (http://www.nosignificantdifference.org/).   
 
Based on the above conclusion, as well as review of models, books and papers related to media selection 
(Air Force 1998; Bahlis 1994 & 1998; Dick and Carey 1996; Driscoll 2001; Gery 1987 & 1991; Fitz-Eng 1994; 
Hirumi 2011, Kibbee 2008, Marx 1999; Miller 1990, Sawyer 1985; US Dept of Defense 1999; US Dept of 
Navy 1990; Weinstein 1987), the following rules are employed by ADVISOR to identify viable delivery 
options and rate their ability in meeting organization, learƴƛƴƎ ŀƴŘ ƭŜŀǊƴŜǊǎΩ ƴŜŜŘǎΥ 
 
1st Rule:  All delivery options supported by the Client are considered. 
 
 

2nd Rule: Delivery options that do not support all critical requirements are eliminated.  For example, if 
Video is required (i.e., critical to the transfer of Knowledge/Skill), then all media (such as Print) 
that do not support Video are eliminated.  Critical requirements are rooted in course content, 
audience characteristics and constraints.  Some of the factors considered by ADVISOR are 
presented below for illustration: 

  

Factor Impact 

Content   

Reason for Course 

Although Electronic Performance Support Systems can quickly zero in on the right 
info to address specific Knowledge/Skill gaps, they are not suited for initial 
training, for example. 

Audio 
If course deals with language, music or radio communications, for example, then 
options that do not support audio are not suited for such program. 

Video 
If video is needed for a customer service course that focuses on detecting and 
interpreting body language, for example, then options that do not support video 
are not suited for such program. 

Stability of Course 
If large segments of the course change frequently, then delivery options with 
lengthy upfront development time, such as Multimedia CBT/WBT, are not suited 
for such programs. 

Guided Discussions 
If the primary objective of a session is to share best practices, then options that 
limit the exchange and sharing of views are not suited for such programs. 

http://www.nosignificantdifference.org/



